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1 Introduction

The program TEMPEST was designed for the calculation of the dynamics and longitudinal

spatial profiles of the wastewater temperature in the sewer. This manual introduces the

concepts behind TEMPEST and explains the program handling. It is organized as follows:

It first discusses the program’s fields of application, its capabilities and the system prere-

quisites. The second chapter focuses on the program handling and explains the conceptual

model formulation. Chapter 3 exemplifies the application of TEMPEST in a heat recovery

project for the assessment of the recoverable amount of heat.

1.1. Background

Raw wastewater contains a considerable amount of energy which can be recovered and

used to produce warm water and for room heating. This is done by means of a heat pump

and a heat exchanger which is installed in the sewer.

The optimal location for the installation of a heat exchanger in the sewer depends on

several criteria. First of all, it is important that the energy consumers are located close

to the site where the heat is recovered. More heat can be reclaimed from the wastewater

if the discharge is high, which is typically the case towards the end of the sewer. On

the other hand, the wastewater temperature usually is highest in the initial part of the

sewer system. An additional aspect to be considered is that the efficiency of a nitrifying

wastewater treatment plant is reduced if its influent wastewater temperature is lowered

(Wanner et al., 2005). Therefore, planning and design of facilities for heat recovery from

raw wastewater require that the changes of the wastewater temperature along the flow

path in the sewer and the effect of heat recovery on the influent temperature of wastewater

treatment plants can be quantified.

The interactive simulation program TEMPEST (temperature estimation) has been devel-

oped to calculate the dynamics and longitudinal spatial profiles of the wastewater temper-

ature in the sewer. The program is based on a new model of the heat balance in sewers

(Dürrenmatt, 2006 and for a summary of the model equations see Appendix A.1). Appli-

cations range from simple steady state estimates of the changes of the wastewater tem-

perature in a single sewer line to full scale simulations of the dynamics of the wastewater

temperature in successive sewer lines with lateral inflows.

1.2. Program Capabilities

TEMPEST targets high applicability in practice. The implemented model requires as few

input data and a priori estimates as possible. TEMPEST applies default values wherever
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2 Chapter 1. Introduction

possible and disposes of a library that already contains parameter values for the most com-

mon soil and pipe types. Generally, it prefers parameters that are either easy to measure

or available from the literature, and internally converts them into the appropriate format.

However, the model includes all processes, which are of primary importance. Its clear and

intuitive graphical user interfaces make it easy to handle.

Some among the major capabilities are:

• The sewer hydraulics is modeled with the dynamic form of the St. Venant equations

(Cunge et al., 1980). Therefore, the user has to provide upstream discharge data

only. To model parameters, such as temperature, humidity and airflow, balance equa-

tions which form a system of one-dimensional partial differential equations (PDEs)

are used (for an overview, see Appendix A.1).

• To yield high accuracy and numerical stability, the two step Lax-Wendroff algorithm

(Press, 2005) is implemented to solve the system of PDEs (for implementation de-

tails, please refer to Appendix A.2).

• TEMPEST applications range from simple steady state estimates of the changes of

the wastewater temperature in a single sewer line to full scale simulations of the

dynamics of the wastewater temperature in large systems of successive sewer lines

with lateral inflows.

• Intuitive graphical user interfaces assist the user in managing data, performing cal-

culations and plotting results. Data can easily be imported from a text file or spread-

sheet and results can be plotted on the screen and exported for further use.

1.3. System Prerequisites

TEMPEST is written in the object oriented programming language C++ and uses the

wxWidgets graphical user interface library. It is compiled for the Microsoft Windows ope-

rating systems and consists of just one executable file, has no dependencies on external

libraries and does not require any software installation. Therefore, the only action to be

taken in order to run the application is to copy or download the executable file and execute

it.

The program has been extensively tested on Windows XP and Windows Vista but it should

also run on previous versions of Windows. Since it numerically solves partial differential

equations and therefore performs a lot of calculations, faster processor clocks yield shorter

calculation times.

1.4. File Format

Models created with TEMPEST can be saved to disk and have the extension “tmo”. Sewer

line definitions, material parameters and time series data as well as numerical settings will

be saved. Therefore, TEMPEST model files can conveniently be exchanged between users

and platforms.



2 Program Handling

The handling of TEMPEST and its dialog boxes are illustrated in

this chapter. The model formulation is explained and it is shown,

how sewer systems can be modeled in TEMPEST. The order of the

sections corresponds to a typical session in which a user first cre-

ates a model file, then defines the model, performs and optimizes

computations and eventually analyzes the results.

2.1. Overview

2.1.1. User Interface

Figure 2.1 shows the main window of TEMPEST upon the start of the program. The

commands for file handling, model creation and editing and computation can be found in

the menus of the menu bar. The commands most often used also are represented in the

toolbar. All commands are listed and described in Table 2.1.

Toolbar

MenubarPP
PP

Figure 2.1.: Main window of TEMPEST.
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4 Chapter 2. Program Handling

Table 2.1.: Menu and toolbar items.

Menu item Hot key Toolbar icon See also

File Alt + F

New Ctrl + N 2.1.2

Open... 2.1.2

Close Ctrl + W – 2.1.2

Save Ctrl + S 2.1.2

Save As... Ctrl + Shift + S – 2.1.2

Export Data... – 2.4

Recent Files... –

Exit Alt + F4 –

Edit Alt + E –

Copy – 2.2.2

Paste – 2.2.2

Preferences – 2.5

Model Alt + M

Add Sewer Line 2.2.1

Remove Sewer Line 2.2.1

Add Time Series 2.2.2

Delete Time Series 2.2.2

Insert Column 2.2.2

Remove Column 2.2.2

Validate Entries and Data

Model Settings... – 2.2.3

Compute Alt + C –

Steady State Solution 2.3

Dynamic Solution 2.3

View Alt + V –

Sewer Lines – 2.2.1

Time Series – 2.2.2

Results – 2.4

Box Zoom 2.4

Pan 2.4

Zoom In 2.4

Zoom Out 2.4

Restore View 2.4

Help Alt + H

About... –
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2.1.2. File Handling

TEMPEST models (consisting of sewer lines, time series and settings) are stored in model

files with the file extension TMO.

The File menu provides the basic functionalities to create TEMPEST models (File – New),

to save a model (File – Save or File – Save As...) or to load a previously created model

from the file system (File – Open...).

2.2. Model Formulation

In TEMPEST, the basic element used to build models of complex sewer systems, is the

“Sewer Line”, which consists of a “Node” followed by a “Conduit” (Dürrenmatt and Wan-

ner, 2008). Nodes are introduced in the sewer at each location, where there are lateral

inflows, changes in the pipe geometry, changes in the material properties of the sewer

pipe, or changes in the surrounding soil, as shown in Figure 2.2. Lateral wastewater in-

flows to the system and inflow temperatures can either be constant values in time or time

series.

Mathematically, “Conduits” represent sets of mass balance equations and “Nodes” repre-

sent sets of continuity conditions of the variables of successive conduits. The variables

considered are discharge and temperature in the wastewater compartment, airflow, tem-

perature and humidity in the sewer headspace, and temperature in the sewer pipe and

the surrounding soil. The hydraulics is modeled with the St. Venant equations (Cunge

et al., 1980) and the airflow with a recently developed model for circular pipes. The heat

and mass transfer processes considered in the model are shown in Figure 2.3. The rate

expressions of the transfer processes were taken from the literature (e.g. Holman, 2002;

Incropera and DeWitt, 2002; Wanner et al., 2004). The complete mathematical model im-

plemented in TEMPEST is described and discussed in two publications (Dürrenmatt, 2006

and Wanner and Dürrenmatt, in preparation; an overview is given in Appendix A.1).

The following sections explain how to input sewer lines and read in time series data.

Saturated soil

Unsaturated soil

N

Sewer line =

Node + 

Conduit

Flow direction

Air exchange

Figure 2.2.: Discontinuities require that nodes are introduced, which separate sewer conduits having different

properties.
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Atmosphere Wastewater
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Sewer pipe

Soil type 1

Soil type 2

Airflow

Wastewater discharge

Heat transfer

Mass transfer

Sources / sinks

System boundary

Lateral 

inflow

Conduit 3Conduit 2Conduit 1
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Biofilm

Figure 2.3.: Compartments and processes considered in the sewer model. Complex systems can be modeled

by series of the elements "node plus conduit".

2.2.1. Sewer Lines

Each model can contain an unlimited number of sewer lines. The management of the

sewer lines is done within the Sewer Lines tab (see Figure 2.4): The Table to the left lists

the successive sewer lines, the form to the right has input fields for the various parameters.

A small image of a sewer cross section with the location where each model parameter is

measured indicated helps the user.

In TEMPEST, the input data needed for wastewater temperature simulations can be di-

vided into three groups: sewer node data, sewer pipe data and surrounding soil data.

The wastewater discharge and temperature, ambient meteorological conditions, and the

Air Exchange Coefficient at the upstream end of a sewer conduit are specified in the Sewer
Node section. The Air Exchange Coefficient describes the capacity for air exchange between

the sewer and the environment. The Sewer Pipe and Soil sections are filled with data

describing these two compartments. By the select fields the user can choose appropriate

values for thermal conductivities, a biofouling factor and friction coefficients of many types

of materials. The COD Degradation Rate describes the production of heat by biological

processes and the Penetration Depth describes the depth to which the soil temperature

TS,inf is assumed to be affected by the sewer. Table 2.2 lists all parameters needed to

model a sewer system with TEMPEST and Figure 2.5 shows a screenshot of the Sewer
Lines form with typical parameter values.

To add a new sewer line, click on in the toolbar or, alternatively, select Add Sewer Line...
from the Model menu. A dialog box as shown in Figure 2.6 appears. You can now name

the series and, if desired, choose a sewer line whose parameter values should be copied

and used for the new sewer line. Confirm by clicking the OK button.

Sewer lines can be deleted by using the Remove Sewer Line command from the Model
menu or by using the button in the toolbar.
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Model tabs
PPPP

Figure 2.4.: New model with empty Sewer Lines form. The model tabs can be used to switch between Sewer
Lines, Time Series and Results view.

Figure 2.5.: Main window displaying the Sewer Lines tab completed with values.
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Table 2.2.: List of all parameters needed in order to perform simulations with TEMPEST.

Name Symbol Unit Constraints

Sewer Node

Inflow QWin m3/s QWin > 0 m3/s for first

and QWin ≥ 0 m3/s for

successive sewer lines

Inflow Temperature TWin °C

Ambient Temperature TA °C

Ambient Relative Humidity phiA – 0 ≤ phiA ≤ 1

Ambient Air Pressure pA mbar pA > 0 mbar

Air Exchange Coefficient b – 0 ≤ b ≤ 1

Sewer Pipe

Type (kst, lambdaP, aP, f) Value from library

Length L m L > 0 m

Nominal Diameter D m D > 0 m

Wall Thickness s m s > 0 m

Slope S0 – S0 > 0

COD Degradation Rate r mg/(m3 s)

Soil

Type (lambdaS, aS) Value from library

Penetration Depth deltaS m deltaS > 0 m

Soil Temperature TS,inf °C

Figure 2.6.: Dialog box for adding new sewer lines.
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2.2.2. Time Series

The inflow of a sewer line can either be described by a constant value or a time series.

To define a time series, the Time Series tab which has a spreadsheet-like interface can be

used. If the user wants to add a new time series for wastewater discharge or wastewater

temperature, he or she has to perform the following steps:

1. Switch to the time series tab (click on the Time Series tab or select Time Series in

the View menu).

2. Select Add Time Series in the Model menu or click on in the toolbar to open the

dialog box showed in Figure 2.7.

3. Name the time series, specify the initial number of rows (corresponds to the number

of data point you want to enter) and select whether your time series should have

a relative or an absolute time scale. The former has seconds as unit starting from

second zero, whereas the latter uses absolute time values (e.g. “25.02.2004 12:00”).

The time series is then added by clicking the OK button. Its name appears in the list

on the left of the Time Series tab and is automatically selected. The time series now

consists of a column for time values only.

4. In order to add a column for inflow or inflow temperature, click on in the toolbar

or open the Model menu and select Insert Column... and specify the parameter you

want to add to column for and a default value (not required). Figure 2.8.

5. Repeat step 4 to add another column and go to step 2 to add additional time series.

If new time series are added, the appropriate select fields in the Sewer Lines tab will

be extended.

To input and edit values, two main methods can be applied: The user can use the arrow

keys or the mouse cursor to navigate in the table and enter values directly or, more easily,

paste values previously copied from a text file or a spreadsheet application (select the

upper left cell were the pasted area should start and select Paste from the Edit menu).

Please consider that TEMPEST expects the date/time values to have the same format as

specified in the system preferences (menu Edit – Preferences...) and that date and time

values must be provided. If this is not the case, TEMPEST tries its best to guess the right

format. Furthermore, consider that data gaps are not allowed and that the date/time value

must increase with increasing row number. The program ignores empty cell at the end of

the table. The columns for time series parameters do not need to have the same number

of rows but the number of rows of the time scale column must be at least as high as the

length of the longest data column.

In Figure 2.9, the screenshot of the Time Series tab of a model which contains one time

series (“25.02-27.02.08”) is shown. The time series has an absolute time scale and values

for both inflow discharge and inflow temperature are specified.
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Figure 2.7.: Dialog box for adding Time Series.

Figure 2.8.: Dialog box for adding new columns.

Figure 2.9.: Time Series tab.
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Time series columns and entire time series can be deleted if no references to sewer lines

exist.

• To delete a column of a time series, select the time series and click on in the

toolbar or select Remove Column from the Model menu alternatively. Then, a dialog

box shows up listing the columns of the current time series. Select the column you

want to be removed and confirm your choice.

• In order to delete an entire time series, be sure that it is selected and click on in

the toolbar (or menu Model – Delete Time Series).

2.2.3. Model Settings

The model settings dialog box includes data on material properties and numerical param-

eters. It can be opened by choosing Model Settings... from the Model menu. This dialog

box has three tabs, the first two tabs allow the user to add and modify data for pipe (Pipe
Types, Figure 2.10) and soil types (Soil Types, Figure 2.11), the third one lets the user

change the numerical parameters. The numerical parameters will be widely discussed in

Section 2.3.4. A selection of parameter values of the most common pipe and soil types is

given in Appendix B.

The forms to edit pipe and soil types have the same user interface but the two types

have different parameters. Types can be added and removed by clicking on the respective

button indicated in Figure 2.10. In order to edit one of the types, select it in the list on top

of the dialog box and change the parameter values in the text fields below. The changes

are applied if the user clicks on the OK button.

Add type

Remove type

BBM

6

Figure 2.10.: Pipe Types tab of the Model Settings dialog box.
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Figure 2.11.: Soil Types tab of the Model Settings dialog box.

2.3. Computation

If the model formulation is complete, calculations can be performed. To open the Compute
Solution dialog box, either select Steady State Solution... or Dynamic Solution... in the

Compute menu, or click on in the toolbar.

Before the Compute Solution dialog box is displayed, TEMPEST verifies the model (the

verification can also be manually started by clicking on in the toolbar or by selecting

Validate Entries and Data in the Model menu).

If errors are found, the Verification Errors dialog box (Figure 2.12) appears. Each error is

listed, its category is illustrated with an icon and the sewer line parameter, the time series

data point, or the setting where it occurred is given. Once all the errors are corrected,

computations can be performed.

2.3.1. Steady State Solutions

The same dialog box is used to compute both steady state and dynamic solutions. A radio

button allows changing the type of calculation within the dialog box. A configuration

ready to perform a steady state simulation is shown in Figure 2.13.

If time series are used in the model, care has to be taken when filling in the Reference
Time: The reference time defines the link between the simulation time in the program and

the data for inflow, inflow temperature, or both. If all time series used have a relative time

scale, the reference time has the unit seconds. If all time series used have an absolute time

scale, the reference time must have a value as illustrated in Figure 2.13. If relative and

absolute time scales are mixed, an absolute date and time must be specified and the time

series with relative time scales are shifted to start with the reference time specified.
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Figure 2.12.: Dialog box that displays errors.

Figure 2.13.: Dialog box for defining computation type and reference time to compute a steady state solution.
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TEMPEST uses linear interpolation algorithms to calculate values between known data.

The first value of the time series is taken for calculation times earlier than the first data

value and vice versa for computation times beyond the last data value of a time series.

2.3.2. Dynamic Solutions

In Figure 2.14, the dialog box of Figure 2.13 is set up for a dynamic calculation. Here, the

same rules for time series apply as discussed in the previous paragraph. It has to be noted

that TEMPEST automatically calculates a steady state solution first in order to generate

initial conditions for the dynamic simulation. The reference time for the calculation of the

steady state solution is set equal to the start time of the dynamic simulation.

In addition to a Start Time and an End Time, one can also choose the Output Timestep: It

specifies the temporal interval by which calculated results will be stored for further use.

2.3.3. Computation Process

Once the calculations have started, a dialog box with a progress bar appears (Figure 2.15)

and informs the user about the ongoing process. Usually, TEMPEST occupies a lot of pro-

cessor time and the ability to work with other application while calculating can be limited

(this is defused if a multi core processor or multiple processors are at your disposition).

Therefore, the calculations can be paused and resumed by clicking on the Pause button

and ended by clicking on the Abort button.

If the steady state can not be found or the convergence is beyond the tolerance, TEMPEST

stops the calculation and gives advice for further optimization of the numerical parame-

ters.

When finished, the dialog box with additional information, such as total computation time,

stays on the screen until it is closed.

2.3.4. Numerical Parameters

TEMPEST tries to guess the best suiting numerical parameters, though numerical settings

can still be modified by the user to improve accuracy and optimize calculation time. These

Figure 2.14.: Dialog box for defining computation type and reference time to compute a dynamic solution.
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Figure 2.15.: Progress dialog showing typical information on the ongoing process of a dynamic solution.

Figure 2.16.: Dialog box for editing numerical settings.

settings can be accessed in the Numerics tab of the Model Settings dialog box (Figure

2.16). To open the dialog box, click on Model Settings... in the Model menu and select the

appropriate tab, or click on the Numerical Settings button in the Compute Solution dialog

box (Figure 2.13 and Figure 2.14).

Three groups of parameters can be modified: Parameters for the Newton-Raphson iterator,

the soil module structure and the PDE solver (cf. Appendix A.2). The parameters together

with a short description and the implemented default values are given in Table 2.3.

The numerical settings are stored together with the model in the TEMPEST file “Model-

name.tmo”.

2.4. Results: View and Export

The results of a computation are displayed in the Results tab (Figure 2.17). It consists of

five sub panels:
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Table 2.3.: List of the numerical parameters needed by simulations performed with TEMPEST.

Parameter Description Default value

Newton-Raphson Iterator

Tolerance for Convergence This is a relative value which spec-

ifies the accuracy that must be ob-

tained in order to stop the iteration.

0.001

Pipe/Soil Module Structure

Number of Pipe Layers Defines the discretization of the

pipe in radial direction: the num-

ber of radial layers the pipe will be

divided in.

5

PDE Solver

Max. Courant Number If the step size in time is auto

computed, the solver tries to keep

the Courant number lower than the

given value.

0.95

Rel. Tolerance Steady State Defines the relative tolerance which

must be reached for the solver to

abort the relaxation for steady state.

5x10−5

Max. Iterations (Steady State) If steady state cannot be reached,

the solver will stop after this num-

ber of steps.

10 000

Stepsize in Space Defines the spatial discretization

along the flow path in the sewer.

10 metres

Stepsize in Time The discretization in time can either

be automatically computed or spec-

ified by the user.

(autocompute)

Apply Filter To improve stability and avoid nu-

merical artifacts, a non linear fil-

ter can be applied to suppress high

frequency oscillations of calculated

variables.

Enquist 2.1
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Figure 2.17.: Main window displaying the calculation Results tab. The wastewater and sewer air temperature

as well as the temperature of the pipe layers are plotted.
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• Data selection (top left and bottom left): Either the time or the location for which

the results are to be plotted and listed can be selected.

• Data table (bottom right): Lists the numerical values of the data series for the time

value or location selected.

• Plot panel (top center): Visualizes the listed data.

• Data series panel (top right): The user can select the data series to be plotted.

Several tools are at your disposition to navigate and zoom within the plot panel. The

mouse cursor can either be in box zoom state or pan state. In order to switch between

these states use the and the icon in the toolbar. If the box zoom state is activated, a

rectangular box can be drawn into the plot area which will then be zoomed in. If the mouse

cursor is in pan state, the clipping can be shifted (click and hold left mouse button while

moving). The and commands can be used to zoom in and zoom out, respectively. To

restore the original view, click on .

Cells, rows, columns or the entire data table can be selected and the selection may then

be copied to the clipboard (menu Edit – Copy).

The calculated values can also be exported for external use. Figure 2.18 shows the Data
Export dialog box (File menu - Export Data...) in which the variables, time and location as

well as output format can be specified. One can export spatial data for a given time step,

time series data at a fixed coordinate or all data together.

2.5. System Preferences

System preferences such as plot pen colors and the default date/time format can be

changed in the Preferences dialog box (Figure 2.19). To open it, select Preferences...
in the Edit menu.

Figure 2.18.: Dialog box for selecting data to export.
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Figure 2.19.: Dialog box for editing the system preferences.



3 Case Study

In this chapter, it is illustrated step by step how TEMPEST can be

used for the optimal planning of heat recovery from the sewer. It is

described, which data must necessarily be collected and it is shown,

how a TEMPEST model is created, calibrated and validated, and

then is used for the modeling of load scenarios.

3.1. Introduction

A fictitious heat recovery project was defined as follows: It is planned to erect a new

building close to manhole RS 4943 in Rümlang (see Figure 3.1). Since a lot of attention

is given to ecological aspects during all phases of the building project, the project team

also wants to assess the potential of using heat that is reclaimed from the wastewater of a

sewer system situated nearby for room heating and warm water production.

In this fictitious project, TEMPEST is used to model the sewer system and to calculate

different heat recovery scenarios. For each scenario, one must check that the legal con-

straints are fulfilled. Those constraints assure that there will be no negative effects for the

downstream wastewater treatment plant due to the heat recovery (here, we assume that

the plant is located right after manhole RS 3096, 1.845 km downstream of RS 4943). In

the Canton of Zurich, the inflow temperature to the plant must not fall below 8 °C and

the maximum temperature decrease resulting from temperature reclamation must not be

higher than 0.5 °C (AWEL, 2003).

The preparatory work before being able to model the sewer system with TEMPEST is dis-

cussed in Section 3.2. Then, it is illustrated how the considered section of the Rümlang

Rümlang

Oberglatt

Flow direction
Manhole

RS 4943

Manhole

RS 3096

L = 1845 m

500 m

Figure 3.1.: Top view of a section of the sewer between the villages Rümlang and Oberglatt in the Canton of

Zurich, Switzerland
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sewer system can be modeled in TEMPEST (Section 3.3) and how calibration (Section

3.3.2) and validation (Section 3.3.2) are performed using the available data. Two exem-

plary heat recovery scenarios are simulated in Section 3.3.3. Finally, some conclusions

drawn from the project are addressed in Section 3.4.

3.2. Field Measurements and Data Acquisition

In order to model the considered sewer section with TEMPEST, geometrical as well as

material properties must be known. Further, discharge and temperature measurements

and meteorological data must be measured, gathered or estimated for the period in time

which will be used for model calibration and validation.

For the Rümlang sewer, data were measured by an ultrasonic flow meter and a tempera-

ture logger mounted at RS 4943 manhole and a temperature logger in manhole RS 3096

(TEMPEST automatically calculates the hydraulics). The measured discharge and temper-

ature data are plotted in Figure 3.2. To get a good estimate for the ground temperature,

a temperature logger was buried in 1.2 m depth and in 2 m distance from the sewer at

manhole RS 4943.

Information on the geometrical and material properties were made available by the engi-

neering company that has built the sewer section. Based on the type of concrete that has

been used, the parameters of the thermal properties and the friction coefficient of the pipe

were estimated. The thermal properties of the soil were estimated based on the soil dis-

covered on-site. Meteorological data were taken from the closest meteorological station.

The values of these parameters are listed in Table 3.1.
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Figure 3.2.: Discharge and temperature data measured from February 26 to February 28 (left column) and

from March 11 to March 13 (right column) at the manholes RS 4943 and RS 3096.
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Table 3.1.: Geometrical and meteorological parameters, and material properties that describe the sewer sec-

tion RS 4943-RS 3096 in Rümlang. Estimates were made where no data was available. Key

to “Origin” column: IP=implementation plan, E=estimate, AS=ANETZ meteorological station,

L=literature (cf. Appendix B).

Parameter Symbol Value Unit Origin

Length L 1845 m IP

Nominal diameter D 0.9 m IP

Wall thickness s 0.1 m IP

Sewer slope S0 0.0091 - IP

Friction coeff. kst 70 m1/3 s−1 E

Fouling factor f 200 W/(m2 K) L

COD degradation rate r 0.6-2.8 mgCOD/(m3 s) L

Soil penetration depth δS 0.1 m E

Air exchange coeff. b 0.1 - E

Ambient temperature TA 8.3 °C AS

Ambient air pressure pA 966 mbar AS

Relative humidity ϕ 0.75 - AS

Soil temperature TS,in f 5.5 °C M / E

Thermal conductivity pipe λP 0.3-2.5a W/(m K) IP / L

Thermal conductivity soil λS 0.25-2.5b W/(m K) IP / L

Thermal diffusivity pipe aP 0.4 - 0.6 a m2/s IP / L

Thermal diffusivity soil aS 0.3 - 0.8 b m2/s IP / L

aReinforced concrete
bGravel with a porosity of 50% and 50% saturated
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Figure 3.3.: Main window of TEMPEST as it shows up when the TEMPEST executable file is run.

3.3. Modeling with TEMPEST

In order to simulate the effect of heat recovery at the upstream site on the downstream

wastewater temperature a new model has to be setup and the parameters of the sewer

section and the time series data must be entered into the model. To do so, run the TEM-

PEST executable file in Windows. The main window as shown in Figure 3.3 appears. After

selecting New from the File menu, a model is created but does not yet contain any sewer

line or time series. Since the relevant data needed is already at the user’s disposition, he

or she can start to define sewer lines now.

Between manhole RS 4943 and RS 3096, there are actually around 30 additional man-

holes. Ideally the sewer should be modeled by 31 sewer lines separated by the manholes.

However, since there are no relevant parameter changes along the flow path, and since the

manhole covers only have small openings with very limited air exchange, it is sufficient to

set up the TEMPEST model with just one sewer line of 1845 m in length.

After clicking on Add Sewer Line in the Model menu, a dialog box appears. In this box

a name (e.g. “Rümlang”) for the new sewer line can by typed in and it can be chosen

whether or not the parameters are to be copied from an already existing line (since you

are adding the first line now, the dropdown list is still empty). The new sewer line is added

by clicking on OK and is now listed on the left side of the sewer lines tab (see Figure 3.4).

You may rename the sewer line at any time later by clicking its name.

The data of the Rümlang sewer as given in Table 3.1 can now be entered into the Sewer
Lines form. For Inflow and Inflow Temperature, the user can either enter a constant value

or define a time series. Because the objective of this project is to choose an heat extrac-

tion mode that does not negatively affect the performance of the downstream wastewater

treatment plant but that reclaims as much heat as possible, the amount of heat extracted

is most certainly not constant over time. Thus, a dynamic simulation must be performed

and therefore the latter be selected.

After clicking on the Time Series radio button for QWin in the Sewer Node panel of the

Sewer Lines tab, you can access a drop down list. Initially, there are no values in the list

because no time series has been added to the TEMPEST model yet. To add a new time

series, click on Add Time Series from the Model menu. A dialog box appears that lets you
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Figure 3.4.: The Sewer Lines tab. A new, empty sewer line has been added to the model and the parameter

values of Table 3.1 have been entered.
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Figure 3.5.: The newly added time series which is named “Measuring Campaign 26.2-28.2.2008” is now

available in the list to the left. The time series data table currently only has a Date / Time row.

name the series (e.g. “Measuring Campaign 26.2-28.2.2008”), define the number of rows

the time series table should have (e.g. 1000) and choose between a relative time scale,

where the time series starts from second zero, and an absolute time scale, depending on

the time format of the measured time series data. Select Absolute (Date/Time). The time

series tab is now visible showing the Date / Time column of the added time series (Figure

3.5).

Before adding inflow and temperature data to the data table, a new column must be added

for each of the two variables. This is done by selecting Insert Column from the Model
menu, for both, the Lateral Inflow [m3/s] and the Lat. Inflow Temperature [°C] parameter.

The Default Value field can be left blank. Note that Lateral Inflow also refers to the inflow

at the upper end of the sewer to be modeled.

In order to fill the cells of the time series table for long time series, it is recommended to

copy-paste the data from a text file or a spreadsheet application like MS Excel. Care has to

be taken that the date/time format in the data source is similar to the format specified in

the TEMPEST preferences (menu Edit – Preferences...). Once the data of the source file is

copied to the clipboard, you can select the upper left cell of the time series table and select

Paste from the Edit menu. The time series named “Measuring Campaign 26.2-28.2.2008”

is now filled with data as shown in Figure 3.6.

If you switch back to the Sewer Lines tab, you can now select the new time series in the

drop down lists for inflow and inflow temperature.

The last parameters to be set before you can start the model calibration are the sewer

pipe and soil type. Every TEMPEST model disposes of a pipe and soil type library which

can be accessed via the menu Model – Model Settings. Add a new pipe type in the Pipe
Types tab of the Model Settings dialog box and enter the estimates from Table 3.1 for the

friction coefficient, the thermal conductivity, the thermal diffusivity and the fouling factor

and assign a comprehensive label (Figure 3.7). The same steps can be performed to add

a new soil type to the library after switching to the Soil Types tab. Save the changes and

close the dialog by clicking on OK. In the Sewer Pipe panel and the Soil panel of the Sewer
Lines tab now select the appropriate Type for pipe and soil, respectively, from the list.

All the data needed to perform simulations has now been entered. If you want to verify

whether the model is complete, select Validate Entries and Data from the Model menu.

Before starting the model calibration, it is recommended to save the model file to disk

(File - Save).
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Figure 3.6.: The data table of the series named “Measuring Campaign 26.2-28.2.2008” is filled with data

copied from a spreadsheet application.

Figure 3.7.: Pipe Types library with an entry for the Rümlang sewer pipe type. Since no exact values were

available, rough estimates have been typed in.
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3.3.1. Model Calibration

In the model calibration phase, one tries to change to model parameters (within certain

limits) so that the output of the model, the simulated wastewater temperature at the lower

end of the sewer section, matches the measured temperature as good as possible.

The time series of the measuring period from February 26 to February 28 2008 (Figure 3.2,

page 21) will be used for the calibration. You can first try to calculate the downstream

wastewater temperature using the parameters given in Table 3.1. Click on Compute – Dy-
namic Solution to open the Compute Solution dialog. The option Compute dynamic solution
is preselected and start and stop times are set to the first and the last time series value

defined in the time series used in the model (Figure 3.8). The Output Timestep [s] can be

changed in order that more or less calculated data are saved as results.

Usually, there is no need to change the numerical settings (see Section 2.3.4). If your

sewer system is rather long but not very dynamic and complex, you can try to increase

the Stepsize in Space [m] in order to speed up the calculation time (click on Numerical
Settings...). If you want to find the optimal stepsize, start with a rather long stepsize and

perform the calculation. Now, decrease to stepsize gradually until the results of the actual

and the last calculation do not differ significantly.

By clicking on Run..., the calculation process starts. A progress bar keeps you informed

about the ongoing process. First, the steady state solution is calculated using the time

series values at the specified start time. The steady state solution is then used as initial

condition for the calculation of the dynamic solution. Since the heat transfer processes

in the sewer pipe and the soil are rather slow, the relaxation time of the steady state

calculation might be shorter than the time needed. A possible way to cope with this

phenomenon is to duplicate the input time series and perform a simulation, e.g. for 6 days

instead of the original 3 days of available input data, and use the results of the last 3 days

of the simulation only.

When the calculation process has finished, you can close the progress dialog. TEMPEST

will now show the Results tab. To compare the values of the calculated and measured

variables at the downstream end of the sewer, the calculated variables must be transferred

to a data analysis or spreadsheet application. You can either export the data by using

the Data Export dialog (File – Export Data..., cf. Section 2.4) or first choose the row “x

= 1845.00 m” in the Parameter vs Time list (lower left), then select the variable row by

clicking on its header in the data table (lower right) and select Copy from the Edit menu.

If the parameters TS,in f , λP, aP, λS, aS, and δS are systematically changed within the ranges

indicated in Table 3.1 on page 22, a good correspondence between the temperatures sim-

ulated and measured in Rümlang is achieved using the values listed in Table 3.2. The

measured and calculated time series are plotted in Figure 3.9.
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Figure 3.8.: The Compute Solution Dialog.

Table 3.2.: Parameters changed during the model calibration and values yielding good correspondence of

measured and calculated data.

Parameter Symbol Value Unit

Soil penetration depth δS 0.11 m

Soil temperature TS,in f 5.5 °C

Thermal conductivity pipe λP 2.3 W/(m K)

Thermal diffusivity pipe aP 0.5 m2/s

Thermal conductivity soil λS 0.7 W/(m K)

Thermal diffusivity soil aS 0.6 m2/s
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Figure 3.9.: Result of the model calibration.
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Figure 3.10.: Result of the model validation.

3.3.2. Model Validation

The model parameter values identified during the model calibration phase now have to

be validated by performing a simulation using time series data that have not already been

used for the model calibration. If the accuracy of the model validation, more precisely the

correspondence of the simulated and the measured downstream temperatures, is satisfy-

ing, the model can be accepted. Otherwise, the calibration must be revised.

In Figure 3.10, the results of a simulation based on the model parameters found by the

calibration and based on inflow and inflow temperature values from March 8 to March

9 2008, are compared to the corresponding measurements. The accordance of the two

series is satisfying.

3.3.3. Heat Recovery Scenarios

By comparing two very simple heat recovery scenarios, the potential of TEMPEST as a tool

to investigate the effects of heat recovery on the downstream wastewater treatment plant

is demonstrated.

In the first scenario, a constant amount of heat of Q̇rec = 350kW shall be reclaimed at the

upper end of the sewer (at manhole RS 4943) and used for the fictitious building planned

next to the manhole. In the second scenario the amount of heat extracted is varied during

the day: Q̇rec = 500kW from 7 am to 10 pm, and Q̇rec = 100kW from 10 pm to 7 am. The

total amount of heat recovered is the same for both scenarios.

When heat is recovered from wastewater, the wastewater temperature decreases. Given

the amount of heat extracted, Q̇rec, the wastewater temperature and discharge upstream
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of the heat exchanger, TW,in and QW , respectively, the temperature after the heat exchanger

TW,out can be calculated using the equation

TW,out = TW,in −
Q̇rec

cp,W ρW QW
(3.1)

where cp,W stands for the specific heat capacity of water and ρW for the density of water.

In order to investigate the effect of the decrease of TW,out on the wastewater temperature

at the downstream end of the sewer, the new time series TW,out , stored, e.g. in an Excel

spreadsheet, can be used as input time series for the model developed above. To do so, add

a new time series in the Time Series tab, add the column for the wastewater temperature

and copy-paste the values of TW,out with the corresponding date/time values into the data

table (proceed as described in the model calibration section). Now, switch to the Sewer
Lines tab and select the new time series as input for the inflow temperature.

In Figure 3.11 the wastewater temperatures at the downstream end of the sewer (manhole

RS 3096) calculated for the two scenarios are compared. One can see that the first scenario

which reclaims a constant amount of heat causes cold downstream temperature peaks at

times where the discharge in the sewer is low (though there is even some warming up

during the flow time in the sewer). In contrast, the diurnal variation of the downstream

temperature calculated for the second scenario is much smaller.

Additional heat recovery scenarios could start from the second scenario and try to further

increase the amount of heat extracted, or to optimize the pattern of the diurnal extraction

profile.

3.4. Conclusions

By means of a simple and fictitious example, a procedure to use TEMPEST for planning of

heat recovery projects is proposed.

To achieve this, the data needed in order to model the sewer section has to be acquired.

Model parameters can be measured on-site or found in the literature. When data is miss-

ing, even a priori estimates may be used. Because TEMPEST yields model predictions

whose accuracy depend on the accuracy of the input data available, sensitivity analyses

can be performed in order to assess the accuracy of the predicted results.

Model calibration is used to adjust the model parameters to the specific conditions of the

sewer considered and model validation serves to test the reliability of the model predic-

tions.

Once the model is set up and tested, it can be used, e.g., to estimate the effect of heat

recovery on the downstream wastewater temperature, to analyze alternative patterns of

heat recovery with diurnal variation or to identify potentially critical conditions for down-

stream wastewater treatment plants.
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Figure 3.11.: Simulation results of two alternative heat recovery scenarios. In the first scenario (left column),

350 kW heat were constantly reclaimed from the wastewater. In the second scenario (right

column), 350 kW of were reclaimed from 7am to 10pm and 100 kW in the remaining time.

The discharge measured at the heat exchanger is plotted in the middle row. In the third row,

the temperature before the heat exchanger (dashed, black line), the temperature after the heat

exchanger (gray line) and the downstream temperature (bold, black line) are indicated.
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A Appendix:
Additional Material

This appendix contains additional material, mainly on the analytical

model (model equations and transfer processes) implemented in

TEMPEST. Additionally, the algorithm used to numerically solve the

partial differential equations is introduced.

35
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A.1. Analytical Model

The sewer system is modeled based on two basic elements “conduits” and “nodes”. Con-

duits, in which the wastewater discharge, airflow, water vapor and temperature are contin-

uous functions in time and space, and are modeled by one-dimensional balance equations.

The element “conduit” is assumed to represent a prismatic pipe with circular cross-section

and without any discontinuity.

Nodes describe discontinuities caused by lateral inflows, head space openings, sudden

changes of the sewer geometry or of material properties, and are modeled by continuity

conditions. Complex sewer systems can be modeled by series of basic elements “node plus

conduit” which is called “sewer line”.

The compartments considered in the model are wastewater, sewer head space, sewer pipe

and surrounding soil. The compartments and the transport, heat and mass transfer pro-

cesses considered in the model are indicated in Figure A.1.

Below, a short overview of the analytical model including the balance equations, the equa-

tions for the process rates and details on the modeling of the nodes is given. For more

detailed explanations, the reader is referred to Dürrenmatt (2006) and Wanner and Dür-

renmatt (in preparation).

δB

s

q
.

PW

q ‘
.

cL

q
.

cP

Heat transfer

Mass transfer

Heat sources / sinks

Wastewater

Sewer air

Sewer pipe

Surrounding soil

q
.

WL q
.

eW

Biofilm

q
.

PL

D/2

q‘
.

COD

Figure A.1.: Cross-section of a sewer line with transfer processes by which the humidity in the sewer

headspace and the temperatures in the wastewater, sewer headspace, sewer pipe and soil are

affected.
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Table A.1.: Balance equations which are solved by TEMPEST. The mathematical formulation of the heat and

mass transfer processes ( j̇ and q̇) can be found in Table A.2. The underlying assumptions are

discussed in depth in Dürrenmatt (2006) and Wanner and Dürrenmatt (in preparation). The

mass and the momentum balance equations of water are known as the St. Venant equations.

Mass Balances

Water discharge (QW ) ∂AW
∂ t =−

∂QW
∂x −

1
ρW

jvP P

Sewer airflow (QL) ∂AL
∂ t =−

∂QL
∂x

Water vapor loading (X)
∂ (AL X)

∂ t =−
∂ (QL X)

∂x + 1
ρW

( jvPP− jkP UL − jkL
′ AL)

Heat Balances

Water temp. (TW )
∂ (AW TW )

∂ t =−
∂ (QW TW )

∂x + 1
cp,W ρW

(q̇PW UW − q̇WL P− q̇vP P+ q̇ω
′ AW )

Sewer air temp. (TL)
∂ (AL TL)

∂ t =−
∂ (QL TL)

∂x + 1
cp,L ρL

(q̇PL UL + q̇WL P+ξ q̇kL
′ AL)

Pipe layer temp. (T ( j)
P )

∂
(

A( j)
P T ( j)

P

)

∂ t = 1
cp,P ρP

(

q̇( j+1/2)
P U ( j+1/2)

P − q̇( j−1/2)
P U ( j−1/2)

P

)

Momentum Balance

Water ∂QW
∂ t =− ∂

∂x

(

QW
2

AW

)

−g AW
∂y
∂x +g AW (S0−S f )

A.1.1. Balance Equations and Transfer Processes

The balance equations for mass, heat and momentum are given in Table A.1. The transfer

processes used in the balance equations are described in detail in Table A.2 (p. 38). Please

notice that the nomenclature used in this section is explained in Table A.3 (p. 39).

A.1.2. Nodes

If the sewer is modeled as a series of conduits, additional continuity conditions must be

fulfilled at the nodes between them. Continuity of TW , TL and X requires that at the nodes

i = 2 to N

QW,i TW,i = QW,i−1 TW,i−1+QWin,i TWin,i (A.1)

and

QL,i TL,i = QL,i−1 TL,i−1+Q∗
L,i TA,i (A.2)

QL,i XL,i = QL,i−1 XL,i−1+Q∗
L,i XA,i (A.3)

if air is inhaled at the node (Q∗
L,i > 0) or

TL,i = TL,i−1 (A.4)

XL,i = XL,i−1 (A.5)

if air is exhaled at the node (Q∗
L,i < 0). In these equations QWin,i and TWin,i are the dis-

charge and water temperature of a lateral inflow, respectively, and TA,i and XA,i are the

temperature and water vapor loading of the ambient air, respectively.
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Table A.2.: Mathematical description of the transfer processes used in the balance equations (Table A.1).

Processa Description

q̇W L = αW L (TW −TL) Convective heat transfer from the compartment “wastew-

ater“ to the compartment “sewer head space”.

q̇SNb = kSNb

(

TS,in f −T ( j=N)
Pb

)

Heat flux from the surrounding soil with temperature

TS,in f to the outermost lower pipe layer segment N.b

q̇( j+1/2)
Pb = kPb

(

T ( j+1)
Pb −T ( j)

Pb

)

Heat flux from the lower pipe layer segment j+1 to the

lower pipe layer segment j.

q̇PW = kPW

(

T (1)
Pb −TW

)

Heat flux from the lower pipe layer segment 1 the com-

partment “wastewater”.

q̇SNt = kSNt

(

TS,in f −T ( j=N)
Pt

)

Heat flux from the surrounding soil with temperature

TS,in f to the outermost upper pipe layer segment N.

q̇( j+1/2)
Pt = kPt

(

T ( j+1)
Pt −T ( j)

Pt

)

Heat flux from the upper pipe layer segment j+1 to the

upper pipe layer segment j.

q̇PL = kPL

(

T (1)
Pt −TL

)

Convective heat transfer from the innermost lower pipe

layer segment the the compartment “sewer head space”.

q̇ω
′ = eCSB rCSB Heat produced by biochemical activity in the compart-

ment “wastewater”.

q̇vP = αvP (psat (TW )− pL) Heat transfer due to evaporation / condensation at the

water-air interface.

jvP = h−1
f g q̇vP Mass flux between the compartments “wastewater” and

“sewer head space” caused by evaporation / condensa-

tion.

q̇kP = αkPt

(

pL − psat

(

T (1)
Pt

))

Mass flux due to condensation at the innermost upper

pipe layer.

jkP = h−1
f g q̇kP Loss of water vapor caused by condensation at the inner-

most upper pipe layer.

q̇kL
′ = h f g ρL (X −Xsat) Condensation in the compartment “sewer head space”

because of oversaturation (reduction of the latent heat).

jkL
′ = ρL (X −Xsat) Condensation in the compartment “sewer head space”

because of oversaturation (reduction of the content of

water vapor).

aFor a mathematical formulation of the parameters αW L, kSNb, kSNt , kPb, kPW , kRPt , kPL, αvP and αkPt , please

consult Dürrenmatt (2006).
bFor a more accurate calculation of the pipe temperature, the pipe is discretized in N radial layers where the

innermost layer is layer j = 1, the outermost j = N. Each layer is then further divided in two segments:

the lower segment Pb interfaces the compartment “wastewater”, the upper segment Pt the compartment

“sewer head space”.
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Table A.3.: Nomenclature used in Table A.1 and A.2.

Symbol Description

Geometrical Variables

An cross section area (n =W for water, L for air and P for a pipe layer)

P Water level width

Un Wetted perimeter (n =W for water, L for air and P for a pipe layer)

Material Properties

cp,n Specific heat capacity (n =W for water, L for air, P for the pipe and S for soil)

TS,in f Temperature of the undisturbed soil

λn Thermal conductivity (n =W for water, L for air, P for the pipe and S for soil)

ρn Density (n =W for water, L for air, P for the pipe and S for soil)

Transfer Processes

j Mass transfer

q̇ Heat transfer

Heat and Mass Transfer Coefficients

k Thermal transmission coefficient

rCOD Biological degradation rate

α heat transfer coefficient

Miscellaneous Variables

eCOD Reaction enthalpy of COD degradation

g Gravitational force

h f g Evaporation enthalpy

pL Partial pressure of water

psat Partial pressure of water of saturated air

S0 Sewer slope

S f Friction slope

TA Ambient temperature

Xsat Water vapor loading of saturated air
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A.2. PDE Solver

To solve the system of one-dimensional partial differential equations, the two step Lax-

Wendroff scheme, an explicit finite volume scheme which is second order in both space

and time (O(∆x2,∆t2)), is used. It omits excessive numerical dispersion, has no amplitude

dissipation and no instabilities due to mesh drifting.

A one-dimensional initial value problem can be written in a flux conservative form as

∂u
∂ t

=−
F(u)
∂x

+S(u) (A.6)

where u (state variables), F (flux terms) and S (source terms) are vectors. The two-step

Lax-Wendroff method calculates interim values ui+1/2 at half time steps t j+1/2:

u j+1/2
i+1/2 =

1
2

(

u j
i+1+u j

i

)

−
∆t

2∆x

(

F j
i+1−F j

i

)

(A.7)

The fluxes F j+1/2
i+1/2 can be calculated using u j+1/2

i+1/2 (similar for u j+1/2
i−1/2 and F j+1/2

i−1/2 ) and finally,

the values u j+1
i at the full time step can be calculated by

u j+1
i = u j

i −
∆t
∆x

(

F j+1/2
i+1/2 −F j+1/2

i−1/2

)

+∆t S j
i (A.8)

After evaluating u j+1
i , the interim values u j+1/2

i+1/2 and u j+1/2
i−1/2 can be discarded.

To assure stability, the Courant-Friedrichs-Lewy (CFL) criterion must be met (Press, 2005).

Since the St. Venant equations contain a non-linear term, it is advisable to apply a filter

that suppresses oscillations caused by waves of short wavelength in order to improve sta-

bility and avoid numerical artifacts after each time step. In TEMPEST, the Enquist 2.1 filter

is implemented for this purpose.
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In this appendix, a collection of different parameter values to de-

scribe the thermal properties of the most common soils and build-

ing materials and friction coefficient for different pipe materials is

provided. The values are collected from the literature.
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B.1. Friction Coefficients kst

In order to describe the wastewater discharge, a friction coefficient is needed. A selection

for several pipe materials is given in Table B.1.

Table B.1.: Friction coefficients kst (Manning-Strickler) for different pipe materials, by Hager (1994).

Condition kst [m1/3s−1]

Pipes

Asbestos-cement pipe 67 - 91

Brick 58 - 77

Cast iron pipe new, cemented 67 - 91

Concrete, monolithic smooth 70 - 83

rough 58 - 67

Concrete pipe 67 - 91

Plastic pipe smooth 70 - 90

Fire-clay pipe 70 - 90

Canals

Coated with

Asphalt 60 - 77

Brick 55 - 83

Concrete 50 - 90
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B.2. Thermal Conductivity and Temperature Diffusivity of
Different Pipe Types

A selection of the thermal conductivity and temperature diffusivity values for different

pipe types is listed in Table B.2.

Table B.2.: Values of the thermal conductivity (λ) and the temperature diffusivity (a) for different pipe ma-

terials.

Thermal conductivity Temperature diffusivity

[ W
m K

] [10−6 m2

s
]

Concretea:

Medium density (1800 kg/m3) 1.15 0.64

Medium density (2000 kg/m3) 1.35 0.68

Medium density (2200 kg/m3) 1.65 0.75

High density (2400 kg/m3) 1.65 0.75

Reinforced (1% steel) 2.30 1.00

Reinforced (2% steel) 2.50 1.04

Bricka:

Clay 1.00 0.63

Concrete 1.50 0.71

Brickb:

Masonry, outside wall 0.64 -

Masonry, inside wall 0.52 -

Brickc 0.38 - 0.52 -

Masonry, saturated with waterd 0.60 -

Cement, hardenedb 0.69 -

Concreteb:

Reinforced concrete 1.12 -

Gravel concrete 0.95 -

Slag concrete, masonry 0.52 -

Concrete, saturated with waterd 1 -

aHohmann et al. (2004)
bVDI (1963)
cBaehr and Stephan (2006)
dBischofsberger and Seyfried (1984)
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B.3. Thermal Conductivity and Temperature Diffusivity of
Different Soil Types

In Table B.3, the thermal conductivity (λ) and temperature diffusivity (a) of different soils

are listed.

Table B.3.: Values of the thermal conductivity (λ) and the temperature diffusivity (a) for different soil types.

Water content Heat conductivity Temperature diffusivity

[-] [ W
m K

] [10−6 m2

s
]

Gravel, coarsea - 0.52

Gravel, crushed rockb - 0.37

Sandy soilc 0.0 0.30 0.24

(40% pore space) 0.2 1.80 0.85

0.4 2.20 0.74

Sandy soil, drya - 0.27

Sandy soil, moista - 0.58

Clay soilc 0.0 0.25 0.18

(40% pore space) 0.2 1.18 0.53

0.4 1.58 0.51

Clay soila - 1.28 -

Peat soilc 0.0 0.06 0.10

(80% pore space) 0.4 0.29 0.13

0.8 0.50 0.12

Humusd - 0.25 -

Soile - 2.00 -

aBaehr and Stephan (2006)
bVDI (1963)
cUnsworth and Monteith (1990)
dScheffer et al. (2002)
eBischofsberger and Seyfried (1984)
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C.1. Program Versions and Changelog

The TEMPEST version history together with a documentation of the major changes is given

in Table C.1.

Table C.1.: TEMPEST changelog

Version Release Date Major Changes

1.01 29th October 2008 Initial public release

1.02 8th December 2012 Fix: Condensation process in air compartment wrong

under certain hydraulic conditions (low discharge to-

gether with small pipe diameter).


